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1
1Installing Saber

This document contains specific information to prepare for and verify installation 
of Saber as well as links to installation instructions.

Install the latest version of Saber in a folder that does not contain an existing 
installation. A common license can serve multiple versions of Saber.

The installation instructions in this document are the most up-to-date available 
at the time of production. However, changes might have occurred. For the latest 
installation information, see Saber release notes or documentation on SolvNet 
at http://solvnet.synopsys.com/.

This document includes the following sections:
■ Preparing for Installation
■ Synopsys Common Licensing (SCL)
■ Supported Platforms and Operating Systems
■ Disk Space and Memory Requirements
■ Installing the Software from EST or a CD
■ Installing the Software from Command Line in Silent Mode
■ Invoking Saber on Windows
■ Invoking Saber on Solaris and Linux
■ Uninstalling the Software
■ Accessing Saber Documentation
■ Customer Support
Saber® Installation Guide 1
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Preparing for Installation

The following points are prerequisites for the installation process.
■ Retrieve your license keys from the SmartKeys Web page. To access the 

SmartKeys webpage, click the SmartKeys link from the Download Center. 

For detailed licensing information, see the Synopsys Licensing QuickStart 
Guide.

■ Solaris and Linux users: You must have system administrator privileges 
when installing licensing or tools in a restricted directory location. The 
installation script requires that the Bourne shell is available at /bin/sh.

■ Windows users: You must have administration privileges for installing and 
uninstalling the tool. In addition, you must close all running Saber 
applications (Sketch or Saber) before starting any Saber installation 
processes on Windows.

■ To download the software by electronic software transfer (EST), you must 
have Netscape Navigator 4.0 or later, Microsoft Internet Explorer 4.0 or later, 
or Mozilla 1.x or later.

■ Verify that your disk space is adequate. See Table 2 on page 5 for 
information on disk space requirements for each platform.

■ The Saber Release Notes provides information about changes in licensing, 
memory requirements, and supported platforms, as well as other 
enhancements and changes regarding Saber. 

To read the release notes, 

1. Go to https://solvnet.synopsys.com/ReleaseNotes (If prompted, enter your 
user name and password. If you do not have a Synopsys user name and 
password, follow the instructions to register with SolvNet.)

2. Click Saber, then click the release you want in the list that appears at the 
bottom.

The Release Notes are in Portable Document Format (PDF) and require a PDF 
file reader to view and print them. 

Note:   To view and print Saber documentation in Portable Document 
Format (PDF), you must have Adobe Acrobat Reader installed 
on your machine. To acquire the latest version of the Adobe 
2 Saber® Installation Guide
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Reader software, free of charge, go to http://www.adobe.com/ 
and click the Get Adobe Reader button. Follow the instructions 
on the Web page. 

Synopsys Common Licensing (SCL)

Synopsys Common Licensing (SCL) provides a single method of obtaining 
licenses used by all Synopsys tools. SCL reduces licensing administration 
complexity, minimizing the effort you expend in installing, maintaining, and 
managing licensing software for Synopsys tools.

Note:   It is recommended that you download and install the latest 
version of SCL. To download the latest version of SCL, click 
"Synopsys Common Licensing" from the Download Center. 

This section covers the following topics:
■ Installing, Administrating, and Troubleshooting SCL
■ SCL Documentation

Installing, Administrating, and Troubleshooting SCL
For information on installing, administrating and troubleshooting SCL see the 
Synopsys Licensing QuickStart Guide. The Synopsys Licensing Quick Start 
provides information on Downloading & Installing SCL, and other information 
that is necessary to administer and troubleshoot SCL.

The Documentation section provides links to the installation readme, release 
notes, administration guide and the FLEXnet User Manual.

Note:   Install a single copy of SCL on your license server to be used with 
all Synopsys tools. Installation of Synopsys tools and SCL is not 
order dependent. That is, you can install SCL before or after you 
install your Synopsys tools. However, you cannot use any 
Synopsys tools reliant on SCL until you have installed and 
configured SCL.
Saber® Installation Guide 3
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SCL Documentation
The Synopsys Common Licensing Installation Notes, Synopsys Common 
Licensing Release Notes, and the Synopsys Common Licensing Administration 
Guide, are also available in PDF format in the SCL installation directory at 
scl_root/docs/scl.

The FLEXnet End Users Guide and FAQ is also available in PDF format in the 
SCL Installation directory at docs/flexlmman.

Supported Platforms and Operating Systems

Table 1 lists the supported platforms, operating systems, and corresponding 
Synopsys platform keywords for this release. Many platforms require operating 
system (OS) patches. 

For detailed information, see the Supported Platforms Guide page on the 
Synopsys Web site. Go to http://www.synopsys.com/products/platforms/
sw_platform.html

Under Supported Platforms Guides, select the appropriate foundation for your 
release. This Web page provides information about supported hardware, 
operating systems, and required OS patches. If the required patch described 
on this page is not available from the platform vendor, install the most recent 
patch instead. 

Table 1 Supported Platforms, Operating Systems, and Keywords

Compute 
Platform

Operating system Synopsys platform
 keyword

Platform 
keyword

Window 
environment

x86 Red Hat Enterprise 
Linux v4.0 and 5.0

linux (32-bit mode)1 IA.32 GNOME

x86 SUSE Enterprise Linux 

v9.and 102

Note: Supported only on 
IA- 32 and AMD 
Opteron

suse32 (32-bit mode) SUSE.32 KDE

Sun SPARC Solaris 9, 101 sparcOS5 (32-bit mode) SUN.32 CDE
4 Saber® Installation Guide
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See the Supported Environments section in Saber release notes for latest 
information on supported platforms. Saber release notes are available at https:/
/solvnet.synopsys.com/ReleaseNotes. For information on accessing SolvNet 
see the Accessing SolvNet section.

Disk Space and Memory Requirements

The disk space requirement varies depending on the platform and the features 
selected for installation. Table 2 shows the maximum space required for 
installing all Saber features on a particular platform. Each CD also includes this 
information in the top-level INSTALL_README.wri file.

x86 Windows Vista 32-bit

Windows XP 
Professional 32-bit

Open GL

x86_64 Windows XP 
Professional x64

Open GL

1. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel EM64T or AMD 
Opteron running Red Hat Enterprise Linux. See http://www.synopsys.com/products/platforms for the latest 
information.

2. Binary-compatible hardware platform or operating system. Note, however, that binary compatibility is 
not guaranteed. See http://www.synopsys.com/products/platforms for the latest information.

Table 2 Saber Disk Space and Memory Requirements (in Megabytes) 

Platform Software 
(maximum)

Default temporary directory 
location

Minimum disk 
space to run 
the installer 

Temporary disk 
space during 
installation

Sun Solaris 1470 /var/tmp 520 700

Linux 1500 /tmp 480 650

Table 1 Supported Platforms, Operating Systems, and Keywords

Compute 
Platform

Operating system Synopsys platform
 keyword

Platform 
keyword

Window 
environment
Saber® Installation Guide 5
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Note:   If there is not enough disk space in the default temporary 
directory, set the environment variable in one of the following 
ways and launch the Saber Installer program: 

setenv IATEMPDIR /home/my_user_name/tmp or

export IATEMPDIR=/home/my_user_name/tmp or

change the Windows system environmental variable %TEMP%.

Installing the Software from EST or a CD

Ensure to close any open Saber applications before proceeding with the 
installation.

This section covers the following topics:
■ Installing for the First Time
■ Installing Incrementally
■ Cancelling Installation

Windows 1310 %TEMP%
 or
%HOME%\Local Settings\Temp

700 600

Table 2 Saber Disk Space and Memory Requirements (in Megabytes)  (Continued)

Platform Software 
(maximum)

Default temporary directory 
location

Minimum disk 
space to run 
the installer 

Temporary disk 
space during 
installation
6 Saber® Installation Guide
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Installing for the First Time
Perform the following steps to install the Saber software:

1. You can install the Saber software in one of the two ways:

Note:   On Windows platform, Saber requires Microsoft Visual C++ 
2008 Redistributable - x86 9.0.30729 software to be installed 
before proceeding with the Saber installation.

2. Place the CD in the CD drive. The following events takes place depending 
on the platform on which you want to install the software:

If you are installing from... then...

EST Download the Saber release to a temporary 
directory. You can obtain the latest Saber download 
instructions from the Release Library, which is 
accessible through SolvNet.

Double click the installer exe. The Saber installer 
automatically pre-installs the required software. If the 
pre-install software already exists, the installer 
continues with installing Saber.

Proceed with Step 3 of this procedure.

a CD Proceed with Step 2 of this procedure

Solaris or Linux Windows

Most Solaris and Linux systems will 
automatically mount the CD. If the CD 
does not mount, see Installing Synopsys 
Tools.

Execute the following commands to invoke 
the Saber installer:

%/cdrom/saber_version_platform

Or

% cd your_cd_path; ./
saber_version_platform

The installation program should start 
automatically. If it does not, double-click 
the setup.exe executable file, located at 
the root level of the CD.

The Saber installer automatically pre-
installs the required software.If the pre-
install software already exists, the 
installer continues with installing Saber.
Saber® Installation Guide 7
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Note:   Mounting the CD might require system administrator 
privileges.

3. The Saber Installer window is launched displaying the Introduction  screen:
8 Saber® Installation Guide
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4. Click Next to choose the installation folder. The Choose Install Folder screen 
is displayed:

The default installation location is automatically resolved and displayed. You 
can choose to install the software to a different location other than the 
default location by clicking the Choose button.

Note:   Ensure that you have write permissions to the specified 
installation location.
Saber® Installation Guide 9
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The table below describes the default installation locations on different 
platforms:

5. Click Next to and select the platform specific features you wish to install from 
the Choose Features screen:

Platform Default install location

Windows C:\Synopsys\Saber\C-2009.06

Solaris /opt/Synopsys/Saber/C-2009.06

Linux /opt/Synopsys/Saber/C-2009.06
10 Saber® Installation Guide
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The following table describes the platform specific features available for 
installation:

Note:   In addition to selecting optional features for installation, you 
can also choose to exclude one or many default features from 
installation by de-selecting the feature check box.

Features Install Type Windows Linux Solaris

Saber Simulator Default X X X

Saber Sketch Default X X X

Mentor Graphics DxDesigner Optional X - -

Mentor Graphics Design Architect Optional X X X

Zuken CR-5000 System Designer Optional X - -

Cadence Virtuoso Optional - X X

CosmosScope Default X X X

Saber Harness Optional X - -

Saber Template Library Default X X X

Component Library Optional X 1

1. Download the Component Library package from http://solvnet.synopsys.com

X1 -2

2. Saber HDL Component Library is not supported on Solaris platform. Download the Classic 
Component Library package from http://solvnet.synopsys.com
Saber® Installation Guide 11
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6. When you select the Component Library for installation and click Next, the 
Choose Component Library Package dialog box is displayed:

7. Specify the path to the directory containing the Component Library .jar file 
by clicking the Choose button.
12 Saber® Installation Guide
C-2009.06-SP1



Chapter 1: Installing Saber
Installing the Software from EST or a CD
8. Click Next to view the pre-installation summary. The Pre-Install Summary 
screen is displayed:

This screen summarizes the information collected and evaluated prior to the 
installation.
Saber® Installation Guide 13
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9. Click install to initiate the installation process. The Installing Saber screen is 
displayed:

Following events occur during the installation process:

• Creates an install log file, and records the install results. The log file may 
be used to trace errors occurred during the installation.

• Installs Java Runtime Environment (JRE) to prepare the install 
environment

• Installs features according to user choice

• Creates desktop icons (windows only)

• Imports registry information into windows registry (windows only)

10. When the installation is complete, the View Release Notes dialog box is 
displayed. Click Yes to view the release notes else click No to close the 
dialog box. 

11. Click Done to exit the Saber Installer program. 
14 Saber® Installation Guide
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Note:   If the installation fails, please refer to the error log file in the 
root of the installation location to fix the problem.

Installing Incrementally
Perform the following steps to proceed with incremental installation of Saber:

1. You can install the Saber software in one of the two ways:

Note:   On Windows platform, Saber requires Microsoft Visual C++ 
2008 Redistributable - x86 9.0.30729 software to be installed 
before proceeding with the Saber installation.

If you are installing from... then...

EST Download the Saber release to a temporary 
directory. You can obtain the latest Saber download 
instructions from the Release Library, which is 
accessible through SolvNet.

Double click the installer exe. The Saber installer 
automatically pre-installs the required software. If 
the pre-install software already exists, the installer 
continues with installing Saber.

Proceed with Step 3 of this procedure.

a CD Proceed with Step 2 of this procedure
Saber® Installation Guide 15
C-2009.06-SP1



Chapter 1: Installing Saber
Installing the Software from EST or a CD
2. Place the CD in the CD drive. The following events takes place depending 
on the platform on which you want to install the software:

Note:   Mounting the CD might require system administrator 
privileges.

Solaris or Linux Windows

Most Solaris and Linux systems will 
automatically mount the CD. If the CD 
does not mount, see Installing Synopsys 
Tools.

Execute the following commands to invoke 
the Saber installer:

%/cdrom/saber_version_platform

Or

% cd your_cd_path; ./
saber_version_platform

The installation program should start 
automatically. If it does not, double-click 
the setup.exe executable file, located at 
the root level of the CD.

The Saber installer automatically pre-
installs the required software.If the pre-
install software already exists, the 
installer continues with installing Saber.
16 Saber® Installation Guide
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4. Select the Incremental Install option and click Next to select the platform 
specific features you wish to install from the Choose Features screen.

Note:   The Choose Features screen tags the feature names with 
(installed) for features that have already been installed before 
under the selected install location.
18 Saber® Installation Guide
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The following table describes the platform specific features available for 
installation:

Note:   In addition to selecting optional features for installation, you 
can also choose to exclude one or many default features from 
installation by de-selecting the feature check box.

Features Install Type Windows Linux Solaris

Saber Simulator Default X X X

Saber Sketch Default X X X

Mentor Graphics DxDesigner Optional X - -

Mentor Graphics Design Architect Optional X X X

Zuken CR-5000 System Designer Optional X - -

Cadence Virtuoso Optional - X X

CosmosScope Default X X X

Saber Harness Optional X - -

Saber Template Library Default X X X

Component Library Optional X 1

1. Download the Component Library package from http://solvnet.synopsys.com

X1 -2

2. Saber HDL Component Library is not supported on Solaris platform. Download the Classic 
Component Library package from http://solvnet.synopsys.com
Saber® Installation Guide 19
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5. When you select the Component Library for installation and click Next, the 
Choose Component Library Package dialog box is displayed:

6. Specify the path to the directory containing the Component Library .jar file 
by clicking the Choose button.
20 Saber® Installation Guide
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7. Click Next to view the pre-installation summary. The Pre-Install Summary 
screen is displayed:

This screen summarizes the information collected and evaluated prior to the 
installation.

Note:   When performing an incremental installation, this field 
displays only those features that are being newly added to the 
previous installation set.

When performing an incremental installation, this field 
calculates and displays the disk space required for only those 
features that are being newly added to the previous 
installation set.
Saber® Installation Guide 21
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8. Click Install to initiate the installation process. The Installing Saber screen is 
displayed:

Following events occur during the installation process:

• Creates an install log file, and records the install results. The log file may 
be used to trace errors occurred during the installation.

• Installs Java Runtime Environment (JRE) to prepare the install 
environment

• Installs features according to user choice

• Creates desktop icons (windows only)

• Imports registry information into windows registry (windows only)

9. When the installation is complete, the View Release Notes dialog box is 
displayed. Click Yes to view the release notes else click No to close the 
dialog box. 

10. Click Done to exit the Saber Installer program. 

Note:   If the installation fails, please refer to the error log file in the 
root of the installation location to fix the problem.
22 Saber® Installation Guide
C-2009.06-SP1



Chapter 1: Installing Saber
Installing the Software from EST or a CD
Cancelling Installation
The following actions are taken when you cancel an in-progress installation: 

Case When you click the Cancel 
button...

then the installation is cancelled...

1 before the pre-request installation 
starts

and any files and folders upto the point of 
cancellation are placed in the temporary 
directory. 
The Saber uninstall program removes all 
files and folders created during the 
cancelled installation.

2 during the pre-request installation and any files and folders upto the point of 
cancellation are placed in the install 
directory.

Navigate to the <installation_path>/
_Pre_Install/ directory and click the 
uninstall.exe. 

The Pre-request uninstall program removes 
all files and folders created during the 
cancelled installation.

3 before Saber installation starts Same as Case 1.

4 during Saber insallation and any files and folders upto the point of 
cancellation are placed in the install 
directory.

Navigate to the <installation_path>/
_Saber/ directory and click the 
uninstall.exe.

The Saber uninstall program removes all 
files and folders created during the 
cancelled installation.
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Installing the Software from Command Line in Silent 
Mode

You can install Saber on Solaris and Linux platforms by using the setup script 
command and on Windows platforms by invoking the setup.exe installation 
program.

By default, the Saber installer invokes the GUI installation program on all 
platforms. You can choose to install the software from the command line in a 
non-interactive mode (silent mode).

Silent mode installation suppresses all interactive and graphic output. You can 
choose to install Saber using one of the following options:
■ Using default settings
■ Using a single command
■ Using an install.properties file

Using default settings
Execute the following command to install Saber using the default settings:

Platform Command

Unix / LInux Saber_<version>_linux.bin - i silent

Windows Saber_<version>_win.exe - i silent

Saber is installed in the default directory, 
C:\Synopsys\Saber\<version>
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Using a single command
Execute the following command on a single line to install Saber using custom 
settings.

Platform Command

Unix / Linux Saber_C-2009.06_linux.bin -i SILENT 
DCHOSEN_INSTALL_FEATURE_LIST=<feature_list> 
DComponent_Source_Folder=<component_library_path> 
DComponent_Source=<component_filename(.jar)> 
DUSER_INSTALL_DIR=<installation_path>

Where:
■ -DCHOSEN_INSTALL_FEATURE_LIST - Specifies the features to 

be installed.
■ -DComponent_Source_Folder - Specifies the path to the folder 

where the component library file is available.
■ -DComponent_Source - Specifies the filename of the component 

library (.jar) file.
■ -DUSER_INSTALL_DIR - Specifies the installation path.

The following features are available for installation:

Feature Name  Short Form

Saber Simulator  simulator

Saber Sketch sketch

Mentor Graphics Design Architect Mentor

Cadence Virtuoso  Cadence

CosmosScope  cscope

Saber Harness (Windows only)  harness

Saber Template Library  template

Note:
If you want to install more than one component, list all the components 
you want to install, separated by a commas.

For example: simulator,sketch,cscope,Cadence,Mentor

Use the forward slash (/) as the delimiter while specifying the 
installation path and the component source folder path. 

For example: /remote/us03ops/clients/leli/Saber
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Windows Saber_C-2009.06_win.exe -i SILENT 
DCHOSEN_INSTALL_FEATURE_LIST=<feature_list> 
DComponent_Source_Folder=<component_library_path> 
DComponent_Source=<component_filename(.jar)> 
DUSER_INSTALL_DIR=<installation_path>

Where
■ -DCHOSEN_INSTALL_FEATURE_LIST - Specifies the features to 

be installed.
■ -DComponent_Source_Folder - Specifies the path to the folder 

where the component library file is available.
■ -DComponent_Source - Specifies the filename of the component 

library (.jar) file.
■ -DUSER_INSTALL_DIR - Specifies the installation path.

The following features are available for installation:

Feature Name  Short Form
Saber Simulator  simulator

Saber Sketch  sketch

Mentor Graphics DxDesigner eProduct

Mentor Graphics Design Architect  Mentor

Zuken CR-5000 System Designer Zuken

CosmosScope  cscope

Saber Harness (Windows only)  harness

Saber Template Library  template

Note: 
If you want to install more than one component, list all the components 
you want to install, separated by a commas.

For example: simulator,sketch,cscope,Zuken,eProduct,Mentor

Use the double backward slash (\\) as the delimiter while specifying the 
installation path and the component source folder path. 

For example: C:\\Synopsys\\Saber

Platform Command
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Using an install.properties file
Define a custom .properties file as an input to the command as follows:

Platform Command

Unix / Linux Saber_<version>_linux.bin - i silent -f 
<path_to_properties_file>

Properties file format:
INSTALLER_UI=silent
USER_INSTALL_DIR=<installation_path>
CHOSEN_INSTALL_FEATURE_LIST=<feature_list>
Component_Source_Folder=<component_library_path>
Component_Source=<component_filename(.jar)>

Where:
■ USER_INSTALL_DIR - Specifies the installation path.
■ CHOSEN_INSTALL_FEATURE_LIST - Specifies the features to be 

installed.
■ Component_Source_Folder - Specifies the path to the folder 

where the component library file is available.
■ Component_Source - Specifies the filename of the component 

library (.jar) file.

The following features are available for installation:

Feature Name  Short Form
Saber Simulator  simulator

Saber Sketch sketch

Mentor Graphics Design Architect Mentor

Cadence Virtuoso Cadence

CosmosScope  cscope

Saber Harness (Windows only)  harness

Saber Template Library  template

Note:
If you want to install more than one component, list all the components 
you want to install, separated by a commas.

For example: simulator,sketch,cscope,Cadence,Mentor

Use the forward slash (/) as the delimiter while specifying the installation 
path and the component source folder path. 

For example: /remote/us03ops/clients/leli/Saber
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Platform Command

Windows Saber_<version>_win.exe - i silent -f 
<path_to_properties_file>

Properties file format:
INSTALLER_UI=silent
USER_INSTALL_DIR=<installation_path>
CHOSEN_INSTALL_FEATURE_LIST=<feature_list>
Component_Source_Folder=<component_library_path>
Component_Source=<component_filename(.jar)>

Where:
■ USER_INSTALL_DIR - Specifies the installation path.
■ CHOSEN_INSTALL_FEATURES_LIST - Specifies the features to be 

installed.
■ Component_Source_Folder - Specifies the path to the folder 

where the component library file is available.
■ Component_Source - Specifies the filename of the component 

library (.jar) file.

The following features are available for installation:

Feature Name  Short Form
Saber Simulator  simulator

Saber Sketch sketch

Mentor Graphics DxDesigner eProduct

Mentor Graphics Design Architect Mentor

Zuken CR-5000 System Designer zuken

CosmosScope  cscope

Saber Harness (Windows only)  harness

Saber Template Library  template

Note:
If you want to install more than one component, list all the components 
you want to install, separated by a commas.

For example: simulator,sketch,cscope,Zuken,eProduct,Mentor

Use the double backward slash (\\) as the delimiter while specifying the 
installation path and the component source folder path. 

For example: C:\\Synopsys\\Saber
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Invoking Saber on Windows

Saber requires only a single license daemon, snpslmd. For additional 
information, see Installing Synopsys Tools.

To run Saber on Windows platforms, 

1. Check that your SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE variable 
is set to a valid licensing server. If licenses are not available, the Saber 
Simulator will fail when invoked.

The port and host name variables correspond to the TCP port and license 
server host name specified in the SERVER line of the Synopsys license file. 

Each license file can contain licenses for many packages from multiple 
vendors. You can specify multiple license files by separating each entry with 
a semicolon (;).

2. Start the tool by going to Start > Programs > Synopsys > Saber version > 
Saber Simulator. The Saber window opens.

3. To exit Saber, choose File > Exit.

Invoking Saber on Solaris and Linux

To invoke Saber, you need to setup the user environment by specifying the 
location of the executable files and set the license environment variable.The 
directory containing the executable commands is located within the ai_bin 
directory in the install_home installation root.

Perform the following steps to invoke and verify the Saber installation:

1. Add the executable file to the path.

If you are using the... then include the following line... in the...

C Shell setenv PATH install_home/
ai_bin:$PATH 

.cshrc file

Bourne, Korn, or Bash 
shell, 

PATH=install_home/
ai_bin:$PATH

export $PATH

.profile, .kshrc, 
or .bashrc file:
Saber® Installation Guide 29
C-2009.06-SP1

http://www.synopsys.com/install


Chapter 1: Installing Saber
Uninstalling the Software
2. Install the latest SCL and define the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE environment variables before you can verify the Saber 
installation.

For information about downloading and installing SCL and on setting the 
license variable, see Installing Synopsys Tools.

3. Navigate to your home directory using the following command.

% cd $HOME

4. Invoke the software by executing the following command.

If the Saber tools are correctly installed, this command invokes the tool.

Uninstalling the Software

The Uninstall program removes all files and folders created through the install 
process.

Note:   Files and folders created by you in the installation directory is not 
considered for removal by the Saber Uninstall program.

To invoke... type...

Saber Sketch % sketch

CosmosScope % scope

Saber Book % saberbook
30 Saber® Installation Guide
C-2009.06-SP1

http://www.synopsys.com/install


Chapter 1: Installing Saber
Uninstalling the Software
Perform the following steps to uninstall Saber:

1. See the table below for information on uninstalling Saber on a specific 
platform:

To uninstall Saber on... choose one of the following option...

Solaris / Linux platform ■ Execute the uninstall program, which is located in the 
<Install_home>/_Saber directory. The uninstall 
program is launched as show in the next step.

■ Delete the entire software directory.

Windows platform ■ Execute the uninstall program, which is located in the 
<Install_home>/_Saber directory. The uninstall 
program is launched as show in the next step.

■ From the Control Panel, select “Add or Remove 
Programs”, select the version of Saber you want to 
uninstall and click the Change/Remove button. The 
uninstall program is launched as show in the next step.

■ Choose Start > Programs > Synopsys > Saber version 
> uninstall. The uninstall program is launched as show 
in the next step.
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2. The Uninstall Saber welcome screen is displayed:
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3. Click the Uninstall button to start uninstalling Saber. The Uninstall Saber 
screen displays the uninstall progress:
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4. Once the uninstall is complete, the Uninstall Complete screen is displayed:

5. Click Done to exit the Uninstall Saber program. 

Accessing Saber Documentation

The documentation for Saber is available as PDF files or as online help.

This section covers the following topics:
■ Viewing and Printing Saber Documentation in Portable Document Format
■ Viewing Saber Online Help
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Viewing and Printing Saber Documentation in
Portable Document Format
To view and print Saber documentation in PDF, you must have Adobe Acrobat 
Reader installed on your machine.

Viewing Saber Online Help
The online Help system is a browser-based HTML Help system. 

To view a Help system, Synopsys recommends the following minimum 
revisions web browsers on the Synopsys-supported platforms (later versions 
should also work):

This section covers the following topics:

Platform Operating Systems Supported Browsers

SunSPARC 
Solaris 32- and 64-bit

Solaris 9 or 101

1. Synopsys does not recommend using Netscape Navigator to view Help on Solaris.

Firefox 1.5, 2.0
Mozilla 1.7

X86 (IA-32) 32-bit and 
Linux 32-bit

RedHat Enterprise Linux 4 or 5
SUSE Linux Enterprise Server 9 
or 10

Firefox 1.5, 2.0, 3.02

Mozilla 1.7
Netscape Navigator 7.0

2. Synopsys recommends using Firefox 3.0 builds 2008052912 or later on Linux.

X86_64 Linux 64-bit Red Hat Enterprise Linux 4 or 5
SUSE Linux Enterprise Server 9 
or 10

Firefox 1.5, 2.0, 3.02

Mozilla 1.7
Netscape Navigator 7.0

X86 Windows XP 
Professional

Windows XP Professional v2002 Firefox 1.5, 2.0, 3.03 
Internet Explorer 6.0
Mozilla 1.7
Netscape Navigator 7.0

3. Synopsys recommends using Firefox 3.0 builds 2008052906 or later on Windows.
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■ How to Set a Default Browser on Windows
■ How to Set a Default Browser on UNIX or Linux
■ Setting MIME Types to View PDFs from Help

How to Set a Default Browser on Windows
On Windows, Help opens the browser associated with .html files (typically 
Internet Explorer).

To use a browser other than Internet Explorer on Windows:

1. Open the browser that you want to use.

2. Open the Add or Remove Programs applet (available from the Control 
Panel).

3. Choose Set Program Access and Defaults.

4. Select Custom and click the down arrow to display the custom menu.

5. Choose “Use my current Web browser” and click OK.

Result: The next time you click Help, the Help content will appear in your 
selected default browser.

How to Set a Default Browser on UNIX or Linux
The Help system finds HTML browsers on UNIX or Linux by searching for 
browsers in this order: Netscape and Mozilla. It searches for these browsers in 
the following locations:

1. It first searches in the directories listed in your $PATH environment variable 
for the following executables in the following order:

netscape6
netscape
mozilla

2. If Help doesn’t find these executables in your $PATH, it searches first for 
netscape6, then netscape, and then mozilla, in the following customary 
locations:

/opt/browser/
/usr/local/bin/
/usr/local/browser/
/usr/bin/browser
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To use a browser other than those listed above on UNIX or Linux, there are two 
methods you can use.

Method A: Open the browser you want to use first:

1. Before you use Help, open the browser you want to use, such as Firefox.

2. Then start Help from your Synopsys application.

The Help document will open in the currently opened browser.

Method B: Link the executable you want to use to one of the executables 
(netscape or mozilla) used by Help by default:

• For example, assume that you want to use your Firefox browser executable 
instead of Mozilla, and that both executables are located in /usr/bin. Make a 
symbolic link from the firefox executable to mozilla as follows:

cd /usr/bin
ln -s firefox mozilla

This will cause Help to start Firefox in place of Mozilla when Help is called.

Note:   If you make this change, all users on this system will start 
Firefox instead of Mozilla on this server, in any context.

Setting MIME Types to View PDFs from Help
Online Help includes PDF versions of the documents, for use in printing. In 
order for links from the Help to the PDF to work, you must set an association in 
your browser for MIME type "application/pdf" with an appropriate PDF viewer 
for your platform. See the documentation for  your particular browser for 
specific instructions on creating MIME-type associations.

Customer Support

Customer support is available through SolvNet online customer support and 
through contacting the Synopsys Technical Support Center. 

This section covers the following topics:
■ Accessing SolvNet
■ Contacting the Synopsys Technical Support Center
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Accessing SolvNet
SolvNet includes an electronic knowledge base of technical articles and 
answers to frequently asked questions about Synopsys tools. SolvNet also 
gives you access to a wide range of Synopsys online services, which include 
downloading software, viewing Documentation on the Web, and entering a call 
to the Support Center

To access SolvNet:

1. Go to the SolvNet Web page at http://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not have a 
Synopsys user name and password, follow the instructions to register with 
SolvNet.)

If you need help using SolvNet, click Help on the SolvNet menu bar.

Contacting the Synopsys Technical Support Center
If you have problems, questions, or suggestions, you can contact the Synopsys 
Technical Support Center in the following ways:
■ Open a call to your local support center from the Web by going to http://

solvnet.synopsys.com/EnterACall (Synopsys user name and password 
required).

Telephone your local support center.

North America
■ Toll: 800-245-8005, or send an e-mail message to saber-

hotline@synopsys.com
■ Europe 

Central Europe: +49-89-99320-0

Northern Europe:

Scandinavia: +46 8 555 202 20

United Kingdom: +44 (0) 1189 965 1186

Southern Europe:

France: +33 (0) 810 810903

Italy: +39 039 6846 700 
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Israel: +972-9-9719600
■ Asia-Pacific:

China: +8610-68029992

India: 1-800-102-7677

Korea: +82-2-3404-2700

Singapore: +65-62967433

Taiwan: 0800079595

Japan: 03-5746-1117
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2Installing Saber Frameways and Co-Simulation Interfaces

This document describes how to install the optional Saber tools in the following 
sections:

This section covers the following topics:
■ Installing the Frameway Integration for Mentor Graphics
■ Troubleshooting a Frameway Integration for Mentor Graphics Installation
■ Installing the Frameway Integration for Cadence
■ Installing the Frameway Integration for eProduct Designer
■ Installing the Frameway Integration for Zuken CR-5000 System Designer
■ Installing the Saber Co-Simulation Interface With ModelSim
■ Installing the Saber Co-Simulation Interface With Verilog
■ Troubleshooting the Saber Co-Simulation Interface With Verilog Installation
■ Setting Up the Software to Use a Remote System

Installing the Frameway Integration for Mentor 
Graphics

This section describes how to install the Frameway Integration for Mentor 
Graphics option, how to set up your environment, and what to do if problems 
occur.

The Frameway Integration for the Mentor Graphics Falcon Framework is loaded 
when you select MGC Frameway Integration on the installation tool menu as a 
part of the software installation procedure.
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For the Saber netlister to function, you must load the CDP package when you 
install the Mentor Graphics software. The complete package name is

CDP V8 Ap SW

Note:   The SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE license 
variable and the PATH environment variable must be defined 
before you run the Frameway Integration or Co-Simulation 
Interface option. 

% set PATH= (install_home/ai_bin $PATH) 

where install_home is the path to the Saber home directory.

(For detailed instructions on setting the license variable, see 
Installing Synopsys Tools, available at http://www.synopsys.com/
support/installation/install_guide.html.) 

This section covers the following topics:
■ Installing the Software
■ Verifying the Environment Variable Settings
■ Creating or Modifying a Location Map File
■ Loading the Saber and CosmosScope Icons
■ Verifying the Installation

Installing the Software
To install the Frameway Integration for Mentor Graphics option, 

1. Verify that $MGC_HOME is set, and test the Mentor Graphics products: 
Design Manager, Design Architect, and Design Viewpoint Editor.

• To invoke Design Manager, enter dmgr.

Exit Design Manager.

• To invoke Design Architect, enter da.

Exit Design Architect.

• To invoke Design Viewpoint Editor, enter dve.

Exit Design Viewpoint Editor.

2. Set up the Mentor Graphics gen_lib library.
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a. Load the Mentor Graphics gen_lib library according to the instructions 
provided by Mentor Graphics.

b. Direct the software to the library by using one of the following methods:

• Define MGC_GENLIB only in the location map file. Usually this definition 
will have already been set as part of the Design Architect installation 
procedure. For more information, see the Installing Mentor Graphics 
Software manual.

• Include the location of the gen_lib library in the MGC_GENLIB 
environment variable. If you set this environment variable, you can also 
include an MGC_GENLIB entry in a location map file or not use a location 
map at all.

3. Verify that the Saber simulator is installed and works correctly. 

4. Load the Frameway Integration software.

If you did not load the Frameway Integration for the Mentor Graphics Falcon 
Framework software at the time the Saber simulator was installed, do so 
now.

5. Add the license information to the license file. If needed, install the licenses 
for the Saber/Verilog Co-Simulation option and the Digital Simulation option.

6. Copy the Saber.dofile files and create symbolic links.

To take advantage of Design Architect and Design Viewpoint userware, you 
must copy the .dofile file from the installation directory to the Mentor 
Graphics MGC_HOME directory.

a. Make this location your current (working) directory. For example, on a 
Sun system enter

% cd $MGC_HOME/shared/etc/cust 

b. If the following directories do not already exist, create and change to 
them:

% mkdir dve
% cd dve

% mkdir userware
% cd userware 

% mkdir En_na

c. Create the following symbolic link:

% ln -s En_na default
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d. Copy the .dofile files by entering

% cp $install_home/Saber/framework/falcon/ \
  userware/dve/setup_Saber.dofile default

e. Return to your home directory.

% cd

7. Create or modify environment variables in your startup file.

If you have scripts that automatically configure your environment, be aware 
that they can overwrite some of the environment variables mentioned in this 
step. You should place the variable declarations described in this step so 
that they are executed last.

To automatically set up your environment variables, use a text editor to 
create the lines in your startup file.

Solaris: For the .cshrc file in the C shell,

• Enter the following lines in the .cshrc file after the setenv 
install_home and setenv MGC_HOME variable definitions:

setenv SABER_FALCON $install_home/Saber/
framework/falcon

setenv AMPLE_PATH $SABER_FALCON/userware
setenv MGC_TYPE_REGISTRY $SABER_FALCON/

saber_rgy/registry/ \ 
  type_registry/saber.rgy

setenv ANLG_IPC_PKG $install_home/Saber/
framework/ \

falcon/ipc
setenv ANALOGY_SABER available
setenv SABER_MGC8_SYMBOLS $SABER_FALCON/symbols

The order of these lines in your .cshrc file is important.

Note:   If AMPLE_PATH exists, add $SABER_FALCON/userware to 
the colon-separated list of paths. Typically, this path is placed 
at the end of the list, but you must determine the appropriate 
order of the list (enter as all one line). If 
MGC_TYPE_REGISTRY already exists, just add 
$SABER_FALCON/saber_rgy/registry/type_registry/
saber.rgy to the colon-separated list of paths. The following is 
an example of how these would be listed in your .cshrc file:
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  setenv AMPLE_PATH $AMPLE_PATH:$SABER_FALCON/userware
 setenv MGC_TYPE_REGISTRY$MGC_TYPE_REGISTRY:$SABER_FALCON/ \
 saber_rgy/registry/type_registry/saber.rgy

For the .profile file in the Bourne shell,

• Enter the following lines in the .profile file after the install_home  and 
MGC_HOME environment variable definitions:

SABER_FALCON="install_home/Saber/framework/
falcon"

AMPLE_PATH="$SABER_FALCON/userware"
MGC_TYPE_REGISTRY="$SABER_FALCON/saber_rgy/

registry/ \  
  type_registry/saber.rgy"
ANGL_IPC_PKG="install_home/Saber/framework/

falcon/ \
  ipc" $SABER_FALCON/
ANALOGY_SABER=available
SABER_MGC8_SYMBOLS="$SABER_FALCON/symbols"
export SABER_FALCON
export AMPLE_PATH
export MGC_TYPE_REGISTRY
export ANLG_IPC_PKG
export ANALOGY_SABER
export SABER_MGC8_SYMBOLS

The order of these lines in your .profile file is important.

Note:   If AMPLE_PATH or MGC_TYPE_REGISTRY already exist, 
add the paths specified above to the existing colon-
separated list of paths. For example, the previous 
AMPLE_PATH and MGC_TYPE_REGISTRY entries could 
be replaced with the following:

AMPLE_PATH="$AMPLE_PATH:$SABER_FALCON/userware"
MGC_TYPE_REGISTRY="$MGC_TYPE_REGISTRY:  \

       $SABER_FALCON/saber_rgy/registry/
type_registry/  \
    saber.rgy"

Windows: On Windows platforms, the Mentor environment variables 
can be set either in the profile file or from the Start menu.

• Add the following lines to the profile.ksh file:
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export ANALOGY_SABER=available
export SABER_FALCON=install_dir/Saber/ \
       framework/falcon
export AMPLE_PATH=$SABER_FALCON/userware
export MGC_TYPE_REGISTRY=$SABER_FALCON/saber_rgy/ \
       registry/type_registry/saber.rgy 
export SABER_MGC8_SYMBOLS=$SABER_FALCON/symbols

If AMPLE_PATH or MGC_TYPE_REGISTRY is used for other applications, 
add the Saber paths to these variables as follows:

export AMPLE_PATH="$AMPLE_PATH;$SABER_FALCON/ \
   userware"
export MGC_TYPE_REGISTRY="$MGC_TYPE_REGISTRY: \
   $SABER_FALCON/saber_rgy/registry/type_registry/ \ 
   saber.rgy"
MGC_TMPDIR=C:/tmp
ANLG_IPC_PKG=$SABER_FALCON/ipc

• Go to Start > Settings > Control Panel > System > Advanced tab > 
Environment Variables. In the User Variable pane, click New and add 
the following settings:

Variable name Variable value

ANALOGY_SABER available

SABER_FALCON install_dir\Saber\framework\falcon

AMPLE_PATH  %SABER_FALCON%\userware

MGC_TYPE_REGISTRY %SABER_FALCON%\saber_rgy\registry\type_registry\ 
    saber.rgy

SABER_MGC8_SYMBOLS %SABER_FALCON%\symbols

MGC_TMPDIR C:\tmp  

ANLG_IPC_PKG %SABER_FALCON%\ipc
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If AMPLE_PATH or MGC_TYPE_REGISTRY is already set for other 
applications, add the following Saber paths:

Verifying the Environment Variable Settings
The environment variables described in the previous steps must be set for non-
interactive invocations of /bin/csh, as well as interactive invocations of whatever 
shell you normally use. You cannot depend on non-interactive shells inheriting 
the environment from interactive shells in either Design Architect or Design 
Manager.

To ensure that the environment variables are correctly set,

1. Source your .cshrc file, create a new shell, or log out and log in.

2. To determine whether the environment is set correctly for interactive shells, 
enter

% printenv

3. View the results to verify each environment variable that was described in 
Step 7 on Installing the Software on page 42. Note that the variables are 
expanded to their absolute paths.

4. To determine whether the environment is set correctly for a non-interactive 
C shell, complete the following steps:

a. Using a text editor, create a file called my_csh_env in your current 
directory containing the following lines:

#!/bin/csh
printenv > analogy_csh_env

MGC_TYPE_REGISTRY old_MGC_TYPE_REGISTRY; \
 %SABER_FALCON%\saber_rgy\registry\type_registry \   
 \saber.rgy

Variable name Variable value

AMPLE_PATH old_AMPLE_PATH;%SABER_FALCON%\userware   

MGC_TYPE_REGISTRY old_MGC_TYPE_REGISTRY;%SABER_FALCON%\

                    saber_rgy\registry\type_registry\saber.rgy
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b. Make the file executable by entering the following command at the shell 
prompt:

% chmod 777 my_csh_env

c. To invoke Design Architect, enter

% da

d. When the Design Architect session window appears, move the cursor 
into the session window area, enter the following command: 

$system("my_csh_env")

e. Exit Design Architect.

The previous steps create the analogy_csh_env file, which contains a 
list of all environment variables in the non-interactive shell created with 
the invocation of Design Architect. Check this file to ensure that the 
environment variables are set correctly.

Creating or Modifying a Location Map File
The MGC_LOCATION_MAP variable points to a location map file. You need to 
modify that location map file. However, if you cannot modify the file (or don’t 
want to), you can copy it to your local directory, modify it, and change the 
MGC_LOCATION_MAP variable to point to your local copy. If the variable is not 
defined, or if you do not know where to find a location map file, ask your system 
administrator. The MGC_LOCATION_MAP variable must point to the location 
map file for both interactive and non-interactive shells, as outlined in the 
previous section. 

It is not sufficient to simply change the variable for your current shell. If you are 
not using a location map, set MGC_LOCATION_MAP to NO_MAP.

To create or modify a location map file,

1. If you need to create a location map file rather than copy an existing one, 
place the following lines at the beginning of the file:

MGC_LOCATION_MAP_2
(blank line)

2. Add the following soft prefixes to the location map file that you are either 
creating or modifying:
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$SABER_MGC8_SYMBOLS
(blank line)
$SABER_FALCON
(blank line)

The Mentor Graphics environment requires that these entries be present in 
the location map file to indicate that they are soft paths. You do not have to 
specify hard paths for the location map entries because you already defined 
them as environment variables, which override the corresponding location 
map entries. However, if you prefer, you can omit the environment variable 
specifications and instead specify the hard paths in the location map entries. 
In either case, the location map entries must be included in the location map 
file.

If you are using the Mentor Graphics Board Station products, a blank line 
after the soft prefix name in the location map file can cause a fatal error. 
Instead, you must specify a hard path for each soft prefix in the location map 
file (except for the MGC_LOCATION_MAP_2 entry).

3. Initialize the startup file by logging out and logging back in.

The installation of the Frameway Integration software is now complete. 

Loading the Saber and CosmosScope Icons
To load the Saber and CosmosScope icons, 

1. Start Design Manager by using the following command:

% dmgr

When Design Manager is running, place the pointer in the Tools window and 
click to activate the menu bar for the Tools window. 

2. Add the Saber toolbox.

a. Select the Toolbox window by clicking in the border of the window.

b. Use the right mouse button to choose “View toolboxes.” 

c. When the $MGC_HOME/toolbox icon appears, choose Edit > Add 
Toolbox. A prompt bar appears on the lower-left side of the Toolbox 
window. 

d. Enter the following full path in the prompt bar and click OK: 

saberfalcon/saber_rgy/toolbox
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In the preceding command, saberfalcon is the full path name to the 
place where the $SABER_FALCON environment variable resides. You 
must either specify a hard path or $SABER_FALCON must be defined in 
the location map. If $SABER_FALCON is defined in the location map, you 
can use this soft name in the prompt bar entry. 

A second toolbox named saberfalcon/saber_rgy/toolbox should now 
appear in the Toolbox window.

3. Make sure the Saber and CosmosScope icons are visible in the Tools 
window.

If the Tools window is not present inside the Design Manager window, 
choose View > Tools. The icons for the Saber simulator and CosmosScope 
should now be present in the Tools window, though you might have to scroll 
through the window to find them.

4. Exit Design Manager.

Verifying the Installation
To verify that the Frameway Integration for Mentor Graphics is installed 
correctly, 

1. Copy the $install_home/test/install/mentor directory to a local location.

2. Navigate to the newly created mentor directory.

3. Set the $SABER_FALCON environment variable to point to your local copy 
of the mentor directory. For example, if you are using the C shell, enter

% setenv SABER_EXAMPLE your_path/mentor
4. Invoke Design Architect by entering the following command:

% da

5. In Design Architect, click the Open Sheet icon to open the Open Sheet 
dialog box.

6. In the Open Sheet dialog box, click the Navigator button, and in the resulting 
List box, select the component you want to install. 

The path to the component appears in the Component Name box of the 
Open Sheet dialog box. 

7. In the Open Sheet dialog box, click OK.

8. Choose Check > Sheet. Close or minimize the “Check sheet” summary.
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9. Choose File > Save Sheet. 

10. Choose Saber > Netlist > Show Netlister Transcript. 

You will be able to watch the netlister process in the resulting Netlister 
Transcript window.

11. Choose Saber > Netlist > Start Netlister. 

This starts the netlister. 

12. After the netlist process has finished without any errors, close the Netlister 
Transcript window.

13.  Invoke Saber Guide by choosing Saber > Start Saber Guide.

14. Open the Saber Guide Transcript window by clicking the cmd Simulation 
Transcript icon.

15. In the Saber Guide Transcript window, execute the following command:

<install.scs

The install.scs test program starts a simulation of a test circuit and then 
loads the resultant plot files into CosmosScope.

Note:   The signals are not plotted in the graph window. To plot the 
same signals in the graph window, use the scope plot 
command in the install.scs command script.

16. If the commands that were executed by the install.scs script produced no 
errors, the communication between the Mentor Graphics environment and 
the Saber simulator is good. If you want to complete the test as was done in 
checking the Saber simulator installation, see steps 7 and 8.

17. Exit Saber and Design Architect.

Troubleshooting a Frameway Integration for Mentor 
Graphics Installation

If you followed the steps in the previous section, the environment for running 
the Frameway Integration for the Mentor Graphics Falcon Framework should be 
set up correctly. However, other factors can affect the operation of the software. 
This section describes potential problems and suggests solutions.

PROBLEM 1
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A schematic window is open and active but there is no Saber menu item in the 
menu bar, no Saber Parts Gallery menu item, and no Saber or CosmosScope 
icons in the palette.

Solution A

The ANALOGY_SABER environment variable is not set to the value available. It 
is also possible that either the variable or the value is misspelled. Setting this 
environment variable correctly causes the Saber menu item to appear in the 
menu bar even if the software has not been loaded. 

Solution B

If the ANALOGY_SABER environment variable is set correctly, other causes 
might be that you executed an old version of Mentor Graphics software or that 
some other third-party userware redefined the menu bar. If fixing these 
potential causes does not solve your problem, contact Customer Support.

PROBLEM 2

A schematic window is open and active and there is a Saber menu item in the 
menu bar, but there is no pull-down menu associated with it.

Solution 

The userware has not been loaded into Design Architect. Enter the following 
command:

% ls $SABER_FALCON/userware

Check that the des_arch, base, and dve directories are listed and that there is 
something in each of these directories. Also, make sure that the AMPLE_PATH 
environment variable contains the exact path that $SABER_FALCON/userware 
resolves to. For information on setting AMPLE_PATH, see Step 7 in Installing 
the Software on page 42.

PROBLEM 3

The first time you open a schematic window, error messages appear in the 
Design Architect transcript window stating that $load_library failed in the 
ipc.ample file.

Solution A

Check that the $ANLG_IPC_PKG/lib/ample_ipc.dl file exists. If not, check the 
ANLG_IPC_PKG environment variable setting, which is defined in 
$install_home/bin/ai_setupmgc and aisetupmgc_csh.

Solution B
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The library mentioned in the $load_library message must have execute 
permissions. Check the permissions of $ANLG_IPC_PKG/lib/ample_ipc.dl to 
ensure that read and execute permissions exist for everybody.

PROBLEM 4

A netlist fails after you chose Saber > Netlist or Saber > Start Saber Guide and 
ran an analysis.

Solution A

If a transcript window appears and shows the error message, fix the problem as 
described. The transcript window shows the actual output of the current run.

Solution B

Check the transcript window carefully for the following message:

dvetos.exe: command not found

Check that your path environment variable points to the install_home/ai_bin 
directory.

PROBLEM 5

The palette icons associated with the Saber products appear as letters or 
numbers rather than pictures in Design Architect, or the Saber simulator tool 
icons (Saber and CosmosScope) do not appear in the Design Manager Tools 
window.

Solution

If the fonts still do not work after you rebuild them, execute the following 
commands: 

% xset fp+ $SABER_FALCON/saber_rgy/registry/fonts
% xset fp+ $MGC_HOME/registry/fonts 
% xset fp rehash

This procedure should get your workstation to recognize the fonts. If you still 
have problems, ensure that everyone has at least read and execute 
permissions on all of the directories identified by the $SABER_FALCON/
saber_rgy/registry/fonts path.
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Installing the Frameway Integration for Cadence

Note:   The SABER_HOME variable and a license environment variable 
must be defined before you install a Frameway Integration or Co-
Simulation Interface option. 

Set the SABER_HOME environment variable as follows: 

% setenv SABER_HOME install_home/Saber

To set the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
license environment variable, see Installing Synopsys Tools.

Before you can correctly install the Frameway Integration for the Cadence 
Design II Environment, you must verify the proper installation and operation of 
the partner software and the Saber software. To make these checks,

1. Test the Design Framework II software installation.

a. Invoke Design Framework II by entering the appropriate command for 
your system. Your invocation command will be similar to one of the 
following examples: icms, ictb, msfb, or icds.

The Frameway Integration for Design Framework II is compatible with 
the Cadence Composer and Analog Artist 4.X.

b. Exit Design Framework II.

Note:   If you are unable to invoke Design Framework II, see the 
appropriate Cadence installation manual for more 
information.

2. Verify that the Saber simulator is installed and works correctly.

3. Set the library environment variables.

Set or modify the path to your LD_LIBRARY_PATH (Sun) variable in your 
.cshrc file. A script is provided to automate this procedure. Simply enter the 
following lines at the command-line prompt:

% ed ’s/$0/ai_setlibpath/’ $SABER_HOME/bin/ \
  ai_setlibpath > ! /tmp/my_setlibpath

% source /tmp/my_setlibpath

4. (Optional) If you will be using a partner simulator with the Saber simulator, 
verify that the Verilog simulator is installed for use as a partner simulator.

5. Load the Frameway Integration software.
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If you did not load the Frameway Integration for the Cadence Design 
Framework II at the time the Saber simulator was installed, do so now.

6. Install the necessary license.

a. Add the license information to the license file.

b. If needed, install the licenses for the Saber/Verilog Co-Simulation option 
and the Digital Simulation option.

7. Create the directories.

You must create a directory named local in cadence standard directory/
tools/dfII and create several directories within the local directory.

a. Make this directory your current (working) directory. For example, on a 
Sun system enter

% cd $cds_root/tools/dfII

b. Create this directory, if it does not already exist, as follows:

% mkdir local

c. Create the following directories in the local directory if they do not 
already exist:

% cd local
% mkdir hnl
% mkdir -p si/caplib
% cd si/caplib

d. Copy the following files to the caplib directory:

• Copy the si_saber_cds.il file to a Saber.il file in the caplib directory and 
change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \ 
si_saber_cds.il  cadence_standard_directory/ \
tools/dfll/local/si/caplib/Saber.il

% chmod 755 cadence_standard_directory/tools/dfll/ \ 
local/si/caplib/Saber.il

• Copy the si_saberHDL_cds.il file to a SaberHDL.il file in the caplib 
directory and change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \
si_saberHDL_cds.il  cadence_install_dir/ \
tools/dfll/local/si/caplib/SaberHDL.il

% chmod 755 cadence_install_dir/tools/dfll/ \
local/si/caplib/SaberHDL.il
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e. Copy the following files to the hnl directory:

• Copy the hnl_saber_cds.il file to a Saber.il file in the hnl directory and 
change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \
hnl_saber_cds.il cadence_standard_directory/ \
tools/dfII/local/hnl/Saber.il

% chmod 755 cadence_standard_directory/tools/dfII/ \
local/hnl/Saber.il

• Copy the hnl_saberHDL_cds.il file to a SaberHDL.il file in the hnl 
directory and change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \
 hnl_saberHDL_cds.il cadence_install_dir/ \
  tools/dfII/local/hnl/SaberHDL.il

% chmod 755 cadence_install_dir/tools/dfII/ \
  local/hnl/SaberHDL.il

8. Enter cd to return to your home directory.

9. Edit your cds.lib file to add symbol information.

The cds.lib file is a part of the Cadence Design Framework II software.

• Edit the cds.lib file to include the path to the Frameway symbols in the 
definition of the library search path. You do this by using ASCII files. For 
example,

DEFINE SaberLib $SABER_HOME/framework/artist/symbols/
SaberLib
DEFINE basic $CDS_HOME/tools/dfII/etc/cdslib/basic
INCLUDE /.../other/.../cds.lib

These files can call other cds.lib files so that system files can be resident 
in a location and referred to with an INCLUDE statement. Environment 
variables can be used as shown.

If the cds.lib file is in your local directory, it is used. Otherwise the ~/
cds.lib file is used. By using a local cds.lib file, you can set design-
specific search paths.

10. In the Cadence Design Framework II directory, create a MAST file 
containing initial configuration information. 

a. To create the file, use an ASCII editor, such as vi, that does not insert 
formatted text and enter
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//Revision 4
//NOTE
// Default template for MAST
// Note:
// Please remember to replace Top Cell
// Library, Cell, and View fields with the 
// actual names used by your design.
//END_NOTE

config mast;
design myLib.myCell:myView;

viewlist mast, schematic, symbol;
stoplist mast, symbol;

endconfig

b. Place the file in the following directory:

$CDS_HOME/tools/dfII/local/hierEditor

c. Name the file MAST and save it.

11. Copy the .artistSaberDefaults.il file. 

The .artistSaberDefaults.il file sets the defaults for menus and dialog boxes 
in Design Framework II. You can copy this file into your home directory and 
modify it to set the defaults you prefer for general use, or you can copy it into 
a particular project directory and then modify it to set the defaults to be used 
for that project. 

If more than one .artistSaberDefaults.il file exists on your system, the 
.artistSaberDefaults.il file in your current (working) directory is used if it 
exists. If not, the .artistSaberDefaults.il file in your home directory is used.

a. Make your home directory or a project directory your working directory.

b. To copy the file to your working directory, enter

% cp $SABER_HOME/framework/artist/ dotfiles/
.artistSaberDefaults.il .

Enter the code all on one line. The space and period at the end are 
important.

c. To change the default working directory for the Cadence Design 
Framework II software, which is set by the .artistSaberDefaults.il file, 
edit the file as follows:
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System administrators: To change the sitewide .artistSaberDefaults.il 
file, edit the file in $SABER_HOME/framework/artist/dotfiles.

Individual users: Edit your local copy of the .artistSaberDefaults.il file. 

• Set the saber_simRunDir template to point to the specific directory you 
want.

Or you can set

saber_simRunDir = getWorkingDir()

• Choose Saber > Set Working Directory and specify the directory you 
want.

• Use a Solaris environment variable called SABER_DEFAULT to set the 
path to the .artistSaberDefaults.il file.

If this path is set and the file is present, this file will be loaded. Otherwise 
the .artistSaberDefaults.il file will be loaded from the home directory or 
the working directory. For example, suppose you set the variable as 
follows: 

setenv SABER_DEFAULT /homes/myfile/latest

If an .artistSaberDefaults.il file exists in /homes/myfile/latest, it will be 
used instead of any other files present on your system. 

12. Load the new ~/.cdsinit file.

To access the integration to Cadence 5.0 or 5.1, you need to create a new 
.cdsinit file and install it in each user’s home directory. Use a text editor, such 
as vi, that does not insert formatted text. 

The contents of the .cdsinit file for this release are different from the contents 
in previous versions. An example of the new file contents follows:
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load(strcat(getShellEnvVar("install_home")\
"/framework/artist/skill/analogy.il "))

;
load(strcat(getShellEnvVar("install_home")\
"/framework/artist/skill/analogyReg.il”));
;
load(strcat(getShellEnvVar("install_home")\

"/framework/artist/skill/viewgen.il "))
;
analogy_menu_creation()
;
printf( "Done with startup

initialization.\n" )

The analogyReg.il and viewgen.il files are necessary only if you are using 
the Frameway Integration for Cadence text views feature. These files are 
used to register the MAST view type. The MAST views must be registered 
before you can create them.

13. Register the MAST views by performing the following steps:   

a. Go to the data.reg file, which is located at 

$SABER_HOME/framework/artist/skill 

b. Do one of the following: 

• Put data.reg into the home directory. 

• Follow the instructions in data.reg to split it into these files:

cds_install/share/cdssetup/registry/data/mast.reg

cds_install/share/cdssetup/registry/data/anlg_verilog.reg

cds_install/share/cdssetup/registry/data/snps_vhdlams.reg

cds_install/share/cdssetup/registry/tool/mastEditor.reg

cds_install/share/cdssetup/registry/tool/anlg_verilog.reg

cds_install/share/cdssetup/registry/tool/snps_vhdlams.reg

c. Load the analogyReg.il and viewgen.il files with analogy.il. Add a line to 
your .cdsinit file that will load all three files.

The viewgen.il file and the analogyReg.il file, which contains the trigger 
functions, are located at 

$SABER_HOME/framework/artist/skill 
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d. To create a MAST view that uses the trigger functions found in 
analogyReg.il, follow the procedures on creating text views in Cadence 
in the Analyzing Designs Using Saber for the Cadence Design 
Framework II manual. 

14. Verify that the menus have been installed correctly, and complete the 
installation.

a. Copy the $SABER_HOME/test/install/cadence directory to a local 
location.

b. Edit your cds.lib file to include the path of the cadence/install library.

c. Invoke Design Framework II by entering the appropriate command for 
your version of the software (for example, icde, icds, icms, asicfe, 
layout, layoutPlus, icca, asicpr, or icfb).

The Saber menu item should appear on the menu bar in the schematic 
window.

d. Choose File > Open. The Open File dialog box appears.

e. In the Open File dialog box, 

• Select Library Name > install.

• Then select Cell Name > install.

• Then select View Name > schematic. 

• Click OK.

f. The schematic window should appear with no errors. Check and save 
the design if necessary.

g. In the schematic window, 

• Choose Saber > Set Working Directory. 

• In the resulting Project Information dialog box, check that the Project 
Directory box is set to your_path/cadence. 

• Click OK.

h. In the schematic window, select Saber > Netlist > Start Netlister. 

This starts the netlister. A simulation window appears that contains the 
netlister transcript. 

i. After the netlist process has finished without errors, close the simulation 
window.

j. Invoke Saber Guide by choosing Saber > Start Saber Guide. 

The design is automatically loaded in Saber.
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k. Open the Saber Guide transcript window by clicking the Simulation 
Transcript icon.

l. In the Saber Guide transcript window, choose File > Load Command 
File. 

m. Navigate to your_path/cadence and load the install.scs file. 

This will execute the commands in the install.scs file. The install.scs test 
program starts a simulation of a test circuit and then loads the resultant 
plot files into CosmosScope.

If the commands that were executed by the install.scs script produced 
no errors, the communication between the Cadence Design Framework 
II and the Saber simulator is good. 

n. Exit Saber and Design Framework II.

Installing the Frameway Integration for eProduct 
Designer 

To complete the eProduct Designer Frameway installation, follow these steps: 

1. Install the Mentor Graphics eProduct Designer software and verify the 
installation.

2. Select the eProduct Designer option during Saber installation to install the 
Frameway software for eProduct Designer.

3. The symbols that are available in 
install_home\Saber\framework\viewlogic\symbols directory 
can be used in DxDesigner environment with both Expedition flow and 
Netlist Flow.

a. To use in Expedition flow:

For each of the partitions under 
install_home\Saber\framework\viewlogic\symbols 
directory, create sbr_partition  in your Central Library and add all the 
symbols under that partition into the new partition that you created in the 
Central Library.

b. To use with Netlist Flow: 
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cd to each sub directory under 
install_home\Saber\framework\viewlogic\symbols  and 
create a directory named "sym" and move all symbols in that directory 
to "sym". Then create two empty files named sym.lib and sch.lib in 
the same directory where you created the "sym" directory.

Find the tool named "mega" in the DxDesigner software installation and 
run mega tool as follows:

          mega . -a

This will archive all the symbols under the "sym" directory and create 
archived files named sym.lib and sym.tbl that contains all the 
symbols.

4. Modify the WDIR, PATH, and license environment variables as follows:

a. Start the System program by choosing Start > Settings > Control Panel 
> System > Environment tab. 

b. Add these paths to the WDIR variable: 

install_home\Saber\framework\viewlogic\standard 
install_home\ai_bin
install_home\Saber\bin
install_home\ePD2007\2007IND\SDD_HOME\standard 
-- ePD Installation

For example the following is a snapshot of the WDIR setting 
if Saber is installed in C:\Synopsys\A-2007.12-SP2 and 
eProduct Designer is installed in C:\MentorGraphics:
C:\Synopsys\A-2007.12-
SP2\Saber\framework\viewlogic\standard;C:\Synopsys\A-
2007.12-SP2\ai_bin;C:\Synopsys\A-2007.12-
SP2\Saber\bin;C:\MentorGraphics\2005BST\SDD_HOME\standard 

c. Add these paths to the PATH variable: 

install_home\ai_bin
install_home\Saber\bin

d. SABER_HOME variable to the install_home directory. For example set 
SABER_HOME to C:\Synopsys\C-2009.06\Saber

5. Modify the license environment variable (SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE) to include the location of the Synopsys license file. 
You can use path or port@hostname syntax. For example,

27000@server1;C:/Synopsys/license.lic 

6. Start DxDesigner and open a design. The Saber menu should be in the 
menu bar to the left of the Help menu.
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Installing the Frameway Integration for Zuken CR-5000 
System Designer 

To complete the Zuken System Designer Frameway installation, follow these 
steps: 

1. Install the Zuken CR-5000 System Designer software and verify the 
installation.

2. Select the Zuken Frameway option during Saber installation to install the 
Frameway software for Zuken System Designer.

3. Ensure that thte CR5_PROJECT_ROOT environment variable points to the 
integration files, for example:

CR5_PROJECT_ROOT = C:\ZDWest\CR5_PROJECT_ROOT

4. Ensure that the SABER_DATA_PATH environment variable points to the 
Saber installation, for example:

SABER_DATA_PATH = C:\synopsys\B-2008.09

Note: B-2008.09 indicates the current version of Saber Installation.

5. Ensure that the ZUKENFW environment variable points to the directory 
containing the “zukenfw” program. For example:

C:\Synopsys\B-2008.09\ai_bin

This variable is used in the menu files (mainmenu.scm) to locate the 
zukenfw program.

6. Ensure that the LM_LICENSE_FILE environment variable includes the 
licenses for Zuken System Designer. For example:

LM_LICENSE_FILE = 7770@stoat

7. Copy netlister files saber_sitk.frm, sabersketch_sitk.frm and 
saberguide_sitk.frm from Saber\framework\zuken to 
C:\ZDWest\CR5_PROJECT_ROOT\zds\etc

8. Reboot the machine and start Zuken System Designer. A Saber menu 
option should appear in the System Designer pull-down menus.
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Installing the Saber Co-Simulation Interface With 
ModelSim

Note:   The SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE license 
environment variable must be defined before you use a 
Frameway Integration or Co-Simulation Interface option. For 
detailed instructions on setting the license variable, see Installing 
Synopsys Tools.

Before you can correctly install the Saber/ModelSim interface, you must verify 
the proper installation and operation of the ModelSim software and the Saber 
software.

To correctly set up the Saber/ModelSim interface with the correct master-slave 
relationships, perform the following operations:
■ For Solaris:

If ModelSim is master, enter

% setenv SABER_MODELSIM install_home/Saber/ \
    bin/sabermti.so 
% set path=(install_home/ai_bin $path)
% setenv LD_LIBRARY_PATH:$install_home/ \
    Saber/bin

If Saber is master, enter

% setenv SABER_MODELSIM install_home/Saber/ \
    bin/sabermti.so

$PATH must include the path to the ModelSim executable files.
■ For Windows:

1. Open the Environment Variables dialog box. 

For example, on a Windows system, choose Start > Settings > Control 
Panel > System > Advanced > Environment Variables.

2. Set the SABER_MODELSIM variable to

install_home\Saber\sabermti.dll

3. If ModelSim is the master, add the following line to the PATH variable:

install_home\ai_bin;install_home\Saber\bin

4. PATH must include the path to the ModelSim executable files.
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Installing the Saber Co-Simulation Interface With 
Verilog 

Note:   The SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE license 
variable must be defined before you install a Frameway 
Integration or Co-Simulation Interface option. See Installing 
Synopsys Tools.

To simulate mixed-signal designs by using Verilog-XL as a partner simulator 
with the Saber simulator, you will need the following licenses:
■ Licenses for the Saber/Verilog Co-Simulation Interface (SABER/

VERILOG_MM)
■ A license from Cadence Design Systems for the Verilog-XL simulator

To build the Verilog executable file, you need to run the vconfig utility provided 
by Cadence. 

Set or modify the path to your LD_LIBRARY_PATH (Sun) variable in your .cshrc 
file. 

See the instructions for linking Verilog executable files in the Cadence 
documentation.

To install your Saber/Verilog software,

1. Install the software.

The Saber/Verilog Co-Simulation Interface software is loaded at the same 
time you load the Saber integrated suite of products.

2. Install the licenses.

• If you have not yet installed a license file for your software, you can 
install the license for the SABER/VERILOG_MM option as a part of the 
software installation procedure. 

• If you have already installed a license file for your software, update that 
file by adding the SABER/VERILOG_MM license.

3. Verify that the Saber simulator is installed and works correctly. 

4. Install the Verilog-XL simulator license.

Obtain a Verilog-XL simulator license from Cadence Design Systems, and 
complete any installation instructions provided with the license.

5. Test that the Verilog-XL simulator is installed correctly.
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• Invoke the Verilog-XL simulator by entering the appropriate command 
for your system.

If you cannot invoke the Verilog-XL simulator, see the appropriate 
Cadence Design Systems installation manual for more information.

• Exit the Verilog-XL simulator.

6. (Optional) Create a configuration file for socket communication. 

By default, pipe communication mode is used with the Saber simulator. If 
you want to use socket communication with Saber Guide, you must create 
a config.vmx file as follows:

a. Copy the $install_home/bin/config.vmx file to your working directory.

If you save the config.vmx file to a directory other than your working 
directory, you must modify your $install_home/bin/verilog.scf file 
accordingly.

b. Make no other changes to the verilog.scf file.

The version of the verilog.scf file provided with the software must be 
used when you use the Saber/Verilog software. Check that no other 
versions are present in the data search path ahead of this file.

7. Create the Verilog executable file.

Follow Cadence instructions for invoking vconfig. The instructions likely 
involve adding a directory to your PATH environment variable, for example, 
$CDS_ROOT/tools/bin.

a. When vconfig asks, “What do you want to name the Verilog_XL target?,” 
use the default: verilog.

b. When vconfig asks, “Do you want to include Verilog Mixed-Signal 
Interface?,” answer YES.

c. When vconfig asks for the names of additional files to be loaded, enter 
a single period (.).

d. Create the Verilog executable file by entering 

% ai_make_verilog

For more information about the command, enter

% ai_make_verilog -h

8. Install the Verilog-XL executable file in the desired directory.

9. (Optional) Change the invocation name for the Saber/Verilog simulator.
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You can set the invocation name verilog to an ASCII string of your choosing 
in the invocation_name.scf file.

a. Use an ASCII text editor to open the $install_home/bin/
invocation_name.scf file. 

b. Change the invocation name item from verilog to an ASCII string (for 
example, verilog.scf).

Troubleshooting the Saber Co-Simulation Interface
With Verilog Installation 

This section describes a series of potential problems and suggests solutions.

PROBLEM 1

You get an error while creating the Verilog executable file. 

Solution A

Usually, this error is due to missing or incorrect versions of the C or C++ 
compilers.

Solution B

Some releases of Cadence's vconfig might produce a script that, when run, 
produces undefined symbols:

ld: Undefined symbol
bcopy
getdtablesize
getwd

These symbols are undefined because a Cadence library, virtuous.a, is missing 
from the vconfig output script. The library will be included if you answer the 
vconfig questions in a particular way. In general, those questions that have v as 
their default answer result in the inclusion of virtuous.a. Contact Cadence for 
details.

PROBLEM 2

When you attempt to operate remotely, the error message “remote_host_name: 
remote_host_name: cannot open” is displayed.

Solution 
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The restricted shell version of the rsh command was executed instead of the 
remote shell version. Change your PATH environment variable to include the 
path to the remote shell version of the rsh command. This executable file is 
typically located in either /usr/ucb or /usr/bin. This directory should appear in 
the search path ahead of any directories containing, or pointing to, the 
restricted shell version of the rsh command.

PROBLEM 3

When you attempt to operate remotely, the error message “permission denied” 
is displayed.

Solution

Complete the following steps:
■ Log in to the remote system.
■ Create or modify a file named .rhosts in your home directory on the remote 

system. Include in the file a line that contains the name of your local system. 
To view man page information about the .rhosts file, enter one or both of the 
following commands:

man login
man rsh

PROBLEM 4

You are unable to start Verilog-XL from the Saber simulator.

Solution A

The Verilog-XL executable file does not have execute permission. Change the 
permission on the executable file, using the command

% chmod +x verilog_pathname 

where verilog_pathname is the path to Verilog-XL, including the executable file. 

Solution B

The Verilog-XL executable file is not found in the PATH variable. Change the 
path definition to include the directory where the Verilog-XL executable file 
resides, as follows:

set PATH = (verilog_directory $PATH)

where verilog_directory is the path to the directory containing the Verilog-XL 
executable file.

PROBLEM 5
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Verilog-XL starts but exits immediately with the message

***The partner simulator exited unexpectedly***

Solution A

Verilog-XL cannot find the license file. Examine the Verilog-XL output file 
verilog.log. Look for a line in the log file similar to this one:

Error! ERROR (LM -24): can’t find license file.

If such an error is found, make sure the license variable  
(SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE) points to the appropriate 
license file. Modify the environment variable if necessary. For example,

setenv LM_LICENSE_FILE "...:verilog_license_file"

where verilog_license_file is the path to the Verilog-XL license file.

Solution B

The SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE license environment 
variable is pointing to a Verilog-XL license file that is invalid or has expired. 
Examine the Verilog-XL output file verilog.log. Look for a line in the log file 
similar to this one:

Error! ERROR (LM -35): license for feature has expired.

If such an error is found, obtain a valid license file from Cadence Design 
Systems, install the license file, and set the license environment variable 
accordingly.

PROBLEM 6

When you invoke the Saber/Verilog software with the Verilog-XL simulator 
running on a remote host, the Verilog-XL simulator starts but exits immediately 
with the following error message:

The partner simulator exited unexpectedly

Solution A

There is no permission to execute the shell on the remote host. Verify that you 
have permission to execute an rsh command on the remote host by entering 

% rsh host 'ls' (Sun machines)
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where host is the name of the remote host. If you are unable to execute a 
remote shell, contact your system administrator to arrange for you to execute 
remote shells on the remote host.

Solution B

The remote working directory is invalid. Verify that the working directory on the 
remote host is valid by entering

% rsh host 'cd remote_directory'

where host  is the name of the remote host, and remote_directory is the 
directory where the Verilog-XL simulator will be run on the remote host.

Correct the remote working directory as necessary to ensure a valid path name 
on the remote host, either by modifying the Saber Guide invocation command 
line (-pwd option) or by modifying the verilog.scf file (where the remote working 
directory can be specified).

Solution C

The Verilog-XL executable file cannot be found in the path on the remote 
system. Verify that the Verilog-XL executable file can be found on the remote 
system by entering

% rsh host 'cd remote_directory; verilog -s verilog_file'

where host is the name of the remote host, remote_directory is the directory 
where the Verilog-XL executable file will be run on the remote host, and 
verilog_file is the name of Verilog-XL input file.

Change permissions on the Verilog-XL executable file, or modify the path so 
that the Verilog-XL executable file can be found on the remote system.

Setting Up the Software to Use a Remote System

To set up your Saber/Verilog software to run on a remote system,

1. Set up a user account on the remote system. 

Your system administrator might need to do this for you.

2. Test that you can execute a remote shell locally.

• To test on other systems, enter 

% rsh remote_host_name ls
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